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Welcome

Apple Learning Series: K-6 Web Publishing provides you with materials that help you

easily integrate Web publishing technology into your curriculum. This Getting Started

Guide describes the contents of K-6 Web Publishing, what you need to do before you

use the software, and how to install and begin using the software.

K-6 Web Publishing includes the following items:

m The K-6 Web Publishing CD software case

m Resources on the K-6 Web Publishing Web site

m Quick Start card

K-6 Web Publishing CD software case

The CD software case contains the software for K-6 Web Publishing. Most products

include electronic documentation on the CD, such as user’s manuals or teacher’s

guides.

Note:  If you purchased this kit with a new iMac computer, you have received

additional software CDs, such as AppleWorks. The specific CDs included may vary

depending on the model of iMac.

Web site contents

The K-6 Web Publishing Web site includes the following components:

Curriculum

The Web site includes student projects each of which provides ideas for integrating

the kit software in your classroom. You can view the student projects online or print

them from the Web site. Read the Curriculum Overview on the Web site for detailed

information about the contents and structure of the student projects and the other

curriculum resources.
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Step-by-step instructions

Step-by-step instructions for tasks that involve the kit software and Apple technology

are included on the Web site. These detailed instructions are designed to help your

students complete project-related activities. You can download and print the files

using the Acrobat Reader program. (See “Installing Acrobat Reader” later in this

document.) After you print them, you can laminate them for durability and keep

them near the computer.

Resources

Electronic templates are provided to help you and your students complete some of

the activities in the projects. You can use these files as they are or you can customize

them for your classroom needs. You can download these templates from the Web

site.

The Resources area of the Web site also includes relevant QuickTime movies and

documents that can help you use the templates and projects.

From the kit Web site, you can also access the Web Page Construction Site, a

collection of instructions and other resources to help you create your own Web

pages. You can download this site and use it as a template for customizing your own

instructional Web site. You can then post it on an intranet or use it in your classroom.

Curriculum standards

The K-6 Web Publishing Web site contains correlations information that specifies how

the software and student projects align to curriculum standards. You can search for

correlation information by grade level, subject area, topic, and by select states.

Apple Learning Professional Development online course

K-6 Web Publishing includes an online course that is designed to help you learn how

to use the kit software to enhance the curriculum in your classroom. You access this

course from the K-6 Web Publishing Web site by clicking the Professional

Development button.

The course introduces each of the software products, presents a brief demonstration

of an aspect of the software, and describes how the software can be applied in your

classroom.

Community

This area of the Web site includes forums where you can discuss the K-6 Web

Publishing kit and its online course; additional student projects, submitted by other

teachers, that use the kit software; and teachers’ reviews of the software. You can also

access the extensive resources of Apple Learning Interchange (ALI), the Apple online

community for educators. ALI offers forums, chat rooms, lesson plans submitted by

teachers, special events, and other resources.
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First Steps

Several preliminary steps should be taken before you begin using the software in 

K-6 Web Publishing. These steps are described in “Before You Use the Software,”

below. You should also become familiar with Adobe™ Acrobat™ Reader, the program

you will use to read most of the electronic documentation in this kit and to read

many of the files you download from the K-6 Web Publishing Web site. See “Using

Acrobat Reader,” later in this section, for detailed instructions about using this

program.

Before you use the software

Before you begin to use the software in this kit, you need to select a printer, make

sure that the correct version of QuickTime is installed, and make sure that Acrobat

Reader is installed.

Note:  If you are using the student projects with an iBook or Power Mac G4

computer, you will need a compatible external microphone (available separately) to

complete the activities that involve recording sound.

Select a printer

Some programs in the kit require you to have a printer selected, even if your

computer is not connected to a printer. If you have not already selected a printer,

follow these steps to do so:

1 Open the Apple (K) menu and choose Chooser.

2 In the upper-left section of the Chooser window, click to select the printer driver 

that corresponds to the kind of printer you want to use.

Note:  If your computer is not connected to a printer, select the LaserWriter 8 icon,

then click the close box to close the Chooser. You don’t have to do steps 3 and 4.

3 In the upper-right section of the window, do one of the following:

m If you are connected to a network, click to select the name of the printer you 

want to print to.

m If you are not connected to a network, click to select the printer port or modem

port, whichever port your printer is connected to.
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4 Click the close box to close the Chooser window.

For more information on setting printer options, see the manual that came with your

printer.

Installing QuickTime

Depending on when you purchased your kit, you need QuickTime 4 or QuickTime 5

installed on your computer. See the section on QuickTime Pro, later in this guide, for

detailed installation instructions.

Installing Acrobat Reader

Most of the electronic documentation included on the software CDs and many of the

files you download from the K-6 Web Publishing Web site are in Adobe Acrobat

format, also called “PDF” format. To view and print these files, you need the Adobe

Acrobat Reader program. On some computers, Acrobat Reader is preinstalled in the

Applications folder.

If you purchased K-6 Web Publishing without a computer, you need to check to see if

the latest version of Acrobat Reader is installed on your computer. You can find out

the version number of the Acrobat Reader program installed on your computer by

selecting the Acrobat Reader program icon, then choosing Get Info from the File

menu. The version number is displayed. You can find out the latest version number

by going to the Adobe Web site at www.adobe.com. If you do not have the latest

version, you can download the Installer program for free from the Adobe Web site.

Using Acrobat Reader

With Acrobat Reader, you can easily move around the documentation, search for

specific words or phrases, change the size of a page, and print any pages you want to

have as hard copy.

Moving through a document

You can move through a document in a number of different ways:

m To go to the next page, click the Next Page button ( ) on the toolbar.

m To return to the previous page, click the Previous Page button ( ).

m To return to the first page, click the First Page button ( ).

m To go to a specific page, click the page number box in the status bar at the bottom

of the main window, type the page number, and click OK.

m To search for a specific word, phrase, or activity, click the binoculars button ( )

on the toolbar, type the information you are searching for, and click Find.

For more information about moving around in Acrobat Reader documents, see

“Navigating pages,” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system.
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Changing the size of a page

To magnify or reduce the size of a page, click the box with the magnifying glass ( )

in the status bar at the bottom of the page, then select a magnification level. Refer to

“Viewing documents” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system for detailed information on other page display tools and

options.

Printing pages

You can print any pages of a PDF document while in the Acrobat Reader program.

To print specific pages using most printers, follow these steps:

1 Choose Print from the File menu.

2 Enter the page numbers as they appear at the bottom of the Acrobat Reader window.

These numbers may differ from the numbers that actually appear on the document

itself.

3 Click Print.

Using the Acrobat Reader electronic help system

For more information about using Acrobat Reader, see the program’s electronic help

system. To use the help system, choose Reader Online Guide from the Help menu,

then select the topic you want. Click “How to use this online guide” from the list at

the left of the main page to learn more about using the help system.
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Software Descriptions 
and Installation Instructions

The CD software case contains the software titles included with K-6 Web Publishing.

The following sections provide a brief description of each software product,

information on installing and opening the program, and ways to learn more about 

it. Use these instructions, rather than the instructions that may be in the product’s

electronic manual or Read Me file. For most of the software products, you’ll find a

technical support phone number. (The phone numbers listed in this section were

current at the time the guide was written. However, this information is subject to

change.)

Note:  Do not install any version of QuickTime or Acrobat Reader that might be

included on a product CD. The product CDs sometimes include older versions of

QuickTime or Acrobat Reader. If you install an older version of QuickTime, you may

have problems using the software; an older version of Acrobat Reader might prevent

you from opening electronic documentation or files you download from the K-6 Web

Publishing Web site.

If you install an older version of QuickTime or Acrobat Reader by mistake, you can

easily reinstall the current version. See the section on QuickTime Pro later in this

guide for installation instructions for QuickTime. (After installation, you should make

sure that you remove any older versions of QuickTime from your hard disk.) To

reinstall the latest version of Acrobat Reader, go to the Adobe Web site at

www.adobe.com and follow the onscreen instructions.
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Color It! from MicroFrontier

Color It! is an image editor with which you can create original graphics or modify

existing ones. The images can then be used on Web pages or in other documents or

presentations. You can use Color It! to create, view, and edit animated GIF files;

catalog your image files; and to create many different effects with the filters and

drawing tools.

Installing Color It!

1 Insert the Color It! 4.0 CD into the computer’s CD or DVD drive.

2 Double-click the Color It! 4.0 CD icon, if necessary.

3 Double-click the Install Color It! 4.0 icon.

4 Click Continue in the title screen.

5 Click Continue in the licensing agreement screen.

6 Click Install in the next dialog box.

7 Click Quit when you see a message stating that installation was successful.

Once you have installed the main Color It! 4.0 application, you should update it to

version 4.0.1. The update corrected some problems and added some features. To

update Color It!, follow these steps:

1 Double-click the Color It! 4.0.1 Update icon on the CD.

2 Click Continue in the title screen.

3 Click Continue in the information screen.

4 In the next dialog box, make sure the copy of Color It! that is installed on your hard

disk is the one selected in the list (not the one on the CD), then click Update.

5 Click All Macintoshes in the dialog box that appears.

6 Click Yes when you see a message asking you if you want to delete the old file.

7 Click OK when you see a message stating that the updating was successful.

8 Click Quit in the Update dialog box.

Using Color It!

1 Open the Color It! 4.0 folder on your hard disk, if it’s not already open.

2 Double-click the Color It! 4.0.1 icon to open the application.

3 In the registration dialog box, type your name, organization (optional), and the serial

number. The serial number is located on a sticker on the CD sleeve. Click Register.

A new untitled Color It! window opens.
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Learning more about Color It!

A user’s manual that includes a tutorial is located in the Color It! 4.0 folder on your

hard disk. (The manual is also on the CD in the Documentation folder.) Double-click

the Color It! Manual.pdf icon to open the user’s manual.

The service and support telephone number for Color It! is 515-462-2079.
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Flash 4 or Flash 5 from Macromedia

Flash is a tool for producing Web sites that include innovative interfaces, sound

effects, musical soundtracks, and animation. You can create many different effects

with the program’s drawing tools or you can import artwork from other programs.

Note:  Depending on when you purchased your kit, you received either Flash 4 or

Flash 5. The installation instructions vary slightly depending on the version of the

software you have.

Installing Flash 4

1 Insert the Flash 4 CD into the computer’s CD or DVD drive.

2 Double-click the Flash_4 CD icon, if necessary.

3 Double-click the Flash 4 Installer icon.

4 Click Continue in the opening screen.

5 Click Accept in the software license screen.

6 Click Install in the next dialog box.

7 Click Quit when you see a message stating that installation was successful.

Installing Flash 5

1 Insert the Flash 5 CD into the computer’s CD or DVD drive.

2 Double-click the Flash 5 CD icon, if necessary.

3 Double-click the Flash 5 Installer icon.

4 Click Install in the dialog box that appears to install Flash 5.

5 Click Accept in the software license screen.

6 Click Install in the next dialog box.

Using Flash 4 or Flash 5

1 Open the Macromedia Flash folder on your hard disk, if it’s not already open.

2 Double-click the Flash 4.0a or Flash 5 icon to open the program.

3 Type your name, school, and serial number, then click OK. The serial number is

located on a sticker on the CD sleeve.

4 If you want to register online, click Register Now in the dialog box that appears. If

you don’t want to register at this time, click Don’t Remind Me or Register Later.
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Learning more about Flash

Flash includes a comprehensive help system with eight electronic lessons about the

program’s basic features and a tutorial. It’s a good idea to review the lessons before

taking the tutorial.

To view the lessons, choose Lessons from the Help menu. Select a lesson in the

dialog box that appears, then click OK. To open the help system, choose Flash Help

Topics (Flash 4) or Using Flash (Flash 5) from the Help menu. The help information

opens in your browser software, but you don’t need to be connected to the Internet

to use it. When you’re done using the help system, quit your browser.

The service and support telephone number for Flash is 415-252-9080.
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Freeway 3 LE from SoftPress Systems

Freeway 3 LE is a Web authoring program that lets you create Web sites without being

a computer programmer. You design your pages and Freeway generates the HTML

files that can be viewed on the Web.

To make it easier to get started with Freeway, the K-6 Web Publishing kit includes

sample Web site templates that you can customize for use with the student projects.

The templates are Freeway documents that you can download from the Resources

page on the K-6 Web Publishing site.

Note:  Depending on when you purchased your kit, you received either Freeway LE

or Adobe PageMill as your kit’s Web authoring software.

Installing Freeway 3 LE

1 Insert the Freeway 3 LE CD into your computer’s CD or DVD drive.

2 Double-click the Freeway 3.0 LE CD icon, if necessary.

3 Double-click the Freeway 3.0 LE Installer icon.

4 Click Accept in the license agreement screen.

5 Click Install to install the program on your hard disk.

6 Click Register Later or fill out the online registration information to register the

software. The serial number is located on a sticker on the CD sleeve.

7 Click Quit when you see a message stating that installation was successful.

Using Freeway 3 LE

1 Open the Freeway 3.0 LE Folder if it’s not already open.

2 Double-click the Freeway 3.0 LE icon to open the program.

3 Choose New or Open from the File menu.

Learning more about Freeway 3 LE

Freeway 3 LE includes a getting started guide, called Getting to Know Freeway LE,

which contains a tutorial. A user’s guide is also included. The files for both

documents are located in the Freeway 3.0 LE Folder on your hard disk.

To use the Freeway 3 LE electronic help system, choose Freeway LE Help from the

Help menu. The help system opens in your browser but you do not need to be

connected to the Internet to use it. When you’re done using the help system, quit

the browser or close the browser window.

The K-6 Web Publishing kit also provides a tutorial that takes you through some of

the basic procedures used to customize the Freeway templates that come with the

kit. You can download this tutorial from the kit Web site Resources page.
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Inspiration from Inspiration Software

Inspiration is a versatile program that can be used in all areas of the curriculum. The

program’s diagram features offer you a symbols library and drawing tools to create

“visual maps” of ideas and concepts. You can use the comprehensive outlining

environment to plan and organize reports, Web sites, multimedia presentations, and

other projects. Examples and templates included with the program illustrate a variety

of ways you can use Inspiration in the classroom.

Installing Inspiration

1 Insert the Inspiration CD into the computer’s CD or DVD drive. 

2 Double-click the Inspiration 6 Install icon in the CD window.

3 Click Continue in the opening screen.

4 Click Install in the dialog box that appears.

5 When you see a message stating that installation was successful, click Quit. 

6 In the dialog box that appears, type your name, school, and the serial number. The

serial number is on a sticker on the CD sleeve. Click OK.

7 Select how you want to register the product in the next dialog box.

Note:  Do not install the version of Acrobat Reader that is included in the Manual

folder on the CD. A later version of this program is already installed on your

computer.

Using Inspiration

1 Open the Inspiration 6 folder on your hard disk, if necessary.

2 Click Close in the “Tip of the Day” window when you are done reading it, or click

Next to see more tips.

Learning more about Inspiration

Inspiration includes electronic files for a getting started guide and a user’s manual.

The files for these documents are located in the Manual folder on the CD. 

Inspiration also includes an electronic help system. To use the help system, choose

Inspiration Help from the Help menu, then click Help Topics. Choose Quit from the

Help menu when you’re done using the help system.

The service and support telephone number for Inspiration is 800-877-4292.
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MovieWorks from Interactive Solutions

With this product, you can create QuickTime movies, video, or interactive

multimedia presentations. You can link together scenes sequentially or with buttons

and can export any scene as a QuickTime movie. A suite of five separate applications

makes up MovieWorks. You use the main MovieWorks application for text editing,

adding special effects, sequencing scenes, and opening the Paint, Animator, Sound,

and Video applications.

Note:  Depending on when you purchased your kit, you have received either

MovieWorks 4.6 or MovieWorks Deluxe 5.0. Instructions for both versions are

included here.

Installing MovieWorks 4.6

1 Insert the MovieWorks CD into the computer’s CD or DVD drive.

2 Double-click the MovieWorks CD icon, if necessary.

3 Open the Installers folder.

4 Double-click the MovieWorks Installer icon.

5 Click Continue in the title screen.

6 Click Continue in the next screen.

7 Click Agree in the license agreement window.

8 Make sure your hard disk is selected at the top of the dialog box that appears, then

click Install.

9 In the next dialog box, click Register Now and follow the onscreen instructions if you

want to register now, or click Cancel if you want to register later.

10 Click Quit when you see a message stating that installation was successful.

Note:  Do not install the versions of QuickTime or Acrobat Reader that are included

on the CD. Current versions of QuickTime and Acrobat Reader are already installed

on your computer.

Installing MovieWorks Deluxe 5.0

1 Insert the MovieWorks Deluxe 5.0 CD into the computer’s CD or DVD drive. The

Installers folder on the CD appears on your desktop.

2 Double-click the MovieWorks Deluxe Installer icon.

3 Click Continue in the opening screen, then click Agree in the license agreement

screen.

4 Make sure your hard disk is selected at the top of the dialog box that appears, then

click Install.

5 In the next dialog box, click Register Now and follow the onscreen instructions if you

want to register now, or click Cancel if you want to register later.

6 Click Quit when you see a message stating that installation was successful.
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Using MovieWorks

1 Open the MovieWorks 4.6 or the MovieWorks Deluxe folder on your hard disk, if it’s

not already open.

2 Open the Applications folder.

3 Double-click the MovieWorks or the MovieWorks Deluxe icon to open the

application.

4 Click OK if you see a message about turning off virtual memory.

5 Click Open Project or New Project in the screen that appears.

Learning more about MovieWorks

Both versions of MovieWorks include a menu reference manual, a manual about

compression, and a comprehensive tutorial. With MovieWorks 4.6, the files for these

documents are located in the MovieWorks 4.6 folder on your hard disk. With

MovieWorks Deluxe 5.0, these files are in the Documentation folder on the CD. (You

need to double-click the CD icon to open the CD window to see this folder.) The

MovieWorks Deluxe 5.0 Documentation folder also includes a guide to creating Web

movies and a Release Notes document.

It’s a good idea to complete the tutorial before you use MovieWorks. You can print

the tutorial before you work through it. Samples tutorial files are included on the CD

with both versions of the program.

MovieWorks also includes an electronic help system. To open the help system,

choose MovieWorks or MovieWorks Deluxe from the Help menu. Click Topics, Index,

or Look For to find the information you want. When you’re done using the help

system, click the help window close box.

The service and support telephone number for MovieWorks is 800-385-6518.
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PageMill from Adobe

PageMill enables you to create and maintain dynamic Web pages and whole Web sites

with ease. Its features allow you to use familiar tools and commands to format text

and graphics and create page links. You can also include frames and tables to

enhance your pages.

To make it easier to get started with PageMill, the K-6 Web Publishing kit includes

sample Web site templates that you can customize for use with the student projects.

The templates are PageMill documents that you can download from the Resources

page on the K-6 Web Publishing site.

Note:  Depending on when you purchased your kit, you received either PageMill or

Freeway LE as your kit’s Web authoring software.

Installing PageMill

1 Insert the Adobe PageMill 3.0 CD into the computer’s CD or DVD drive.

2 Double-click the Adobe PageMill 3.0 CD icon.

3 Double-click the Install PageMill 3.0 icon.

4 Click Continue in the opening screen.

5 Choose your country of use in the next dialog box and click OK.

6 Click Accept in the license agreement screen.

7 Click Install in the next dialog box.

8 Click Cancel and then Yes if you want to complete the installation at this time, or 

click Next and follow the onscreen instructions if you want to complete the online

registration.

9 Click Quit when you see a message stating that installation was successful.

Note:  Do not install the version of Adobe Acrobat Reader that is included on the

CD. A later version of that software is already installed on your computer.

Using PageMill

1 Open the Adobe PageMill 3.0 folder on your hard disk, if it’s not already open.

2 Double-click the Adobe PageMill 3.0 icon to open the application.

Learning more about PageMill

A user’s guide and a getting started guide that includes a tutorial are located in the

User Manuals folder on the PageMill CD. If you’re a new PageMill user, it’s a good

idea to take the tutorial or the Apple Learning Professional Development online

course, WebMaker 101, which is an available option with K-6 Web Publishing.

PageMill also includes an electronic help system. You can access the help information

by choosing Contents, Index, or Find from the Help menu. When you’re done using

the help system, click the help window close box to return to your PageMill page.

The service and support telephone number for PageMill is 800-879-3219.
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QuickTime Pro from Apple Computer

QuickTime is the industry-standard technology for creating, playing, and streaming

digital media for Mac OS. It handles video, sound, animation, graphics, text, music,

and 360-degree virtual reality ( VR) screens. QuickTime Pro allows you to create

Internet-ready audio and video; add special effects to movies; make presentations

and slide shows; export video, audio, and pictures to more than a dozen standard file

formats; watch full-screen movie playback; and more.

Note:  Depending on when you received your kit, you have received access to the

features of QuickTime Pro version 4 or 5. With version 4, you first install QuickTime

from a CD included with the kit. With version 5, you download QuickTime 5 from the

Internet and then install it on your computer. With both versions, you then use the

registration information and serial number included on the CD sleeve to unlock

QuickTime Pro.

Installing QuickTime 4

1 Insert the QuickTime 4 CD into the computer’s CD or DVD drive.

2 Double-click the QuickTime Showcase CD icon, if necessary.

3 Double-click the QuickTime Installer icon. ( You may need to first open the

QuickTime 4.1 Installer folder.)

4 Click Continue in the dialog box that appears.

5 Click Agree in the software license information dialog box.

6 Click Continue in the next dialog box to install the full set of QuickTime files on your

computer.

7 Click Restart when you see a message stating that installation was successful.

After you have installed QuickTime on your computer, use the registration

information and serial number located on the CD sleeve to unlock the extended

multimedia capabilities of QuickTime Pro.

Unlocking QuickTime 4 Pro

To unlock QuickTime Pro, follow these steps:

1 Choose Control Panels from the the Apple (K) menu, then choose QuickTime

Settings from the submenu.

2 Choose Registration from the pop-up menu at the top of the control panel window.

3 Click Enter Registration.

4 Use the information and serial number located on the CD sleeve. Type the

information exactly as it appears on the label.

m In the “Registered to” text box, type the text on the first line of the label.

m In the Registration Number text box, type the serial number. If you see a 0 in the

serial number, be sure to type the numeral 0 (zero), not the letter O.

5 Click OK, then close the QuickTime Settings control panel.
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Installing QuickTime 5

Before you unlock QuickTime Pro, you need to download and install QuickTime 5 if

it is not already installed on your computer. If you already have QuickTime 5 installed

on your computer, you can skip these steps and go to “Unlocking QuickTime 5 Pro.”

To find out the version of QuickTime on your computer, choose Control Panels from

the Apple menu, then choose Extensions Manager. Scroll down the list of Extensions

until you see QuickTime. The version number is displayed in this list.

1 Go to www.apple.com/quicktime/download.

2 Follow the onscreen instructions to download and install QuickTime 5 Player. When

you are asked for registration information, enter the information from the label on

the CD sleeve.

m In the Registered To text box, type the text on the first line of the label.

m In the Registration Number text box, type the serial number on the label. If you

see a 0 in the serial number, be sure to type the numeral 0 (zero), not the letter O.

After the installation process is complete, you will be ready to use QuickTime Pro.

Unlocking QuickTime 5 Pro

If QuickTime 5 Pro was already installed on your computer, you just need to unlock

the capabilities of QuickTime 5 Pro using the registration information and serial

number on the CD sleeve. To do so, follow these steps:

1 Open QuickTime Player located in the QuickTime Folder.

2 Choose Preferences from the Edit menu, then choose Registration from the

submenu.

3 Click Edit Registration and enter the information requested.

m In the Registered To text box type the text on the first line of the label.

m In the Registration Number text box, type the serial number on the label. If you

see a 0 in the serial number, be sure to type the numeral 0 (zero), not the letter O.

4 Click OK. Now you’re ready to use QuickTime Pro.

Using QuickTime Pro

Installing QuickTime Pro installs a suite of software tools. QuickTime extension files

are installed in your System Folder’s Extensions folder. The QuickTime Folder on

your hard disk includes QuickTime Player with which you can play, save, bookmark,

edit, and compress movies; PictureViewer that you can use to view and convert still

images; and the QuickTime Plug-in which works with Web browsers to open any

media type supported by QuickTime. You can use the QuickTime Updater to

automatically periodically update your version of QuickTime from the Internet.

To open QuickTime Player, follow these steps:

1 Open the QuickTime Folder on your hard disk.

2 Double-click the QuickTime Player icon to open the program.
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Learning more about QuickTime Pro

QuickTime Player includes an electronic help system. To open the help system when

QuickTime Player is open, choose On-line QuickTime Player Help from the Help

menu. Links to help information are displayed in your browser. Quit your browser to

return to QuickTime Player.

The service and support telephone number for QuickTime Pro is 800-500-7078.
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SmartSound For Multimedia from Sonic Desktop Software

SmartSound For Multimedia provides the tools to produce professional-quality

soundtracks. It includes two programs in one, Maestro for step-by-step soundtrack

creation, and a Sound Editor for specific music editing. You can use SmartSound to

record and edit your own sounds if your computer is set up with a microphone.

Installing SmartSound

1 Insert the SmartSound CD into the computer’s CD or DVD drive.

2 Double-click to open the SmartSound CD icon.

3 Double-click the SmartSound Installer icon.

4 Click Continue in the title screen.

5 Click Continue in the information screen.

6 Click Install in the dialog box that appears.

7 Click Quit when you see a message stating that installation was successful.

Using SmartSound

1 Open the SmartSound For Multimedia ƒ folder on your hard disk if it’s not already

open.

2 Double-click the SmartSound For Multimedia icon to open the application.

3 Type your name and school (both optional) in the dialog box that appears the first

time you use the program, then click OK.

4 Click Accept in the software license agreement window.

5 Click Editor (for the Sound Editor) or Maestro to get started.

Learning more about SmartSound

A user’s guide and an update to the user’s guide are located in the Documentation

folder in the SmartSound For Multimedia ƒ folder on your hard disk. To open the

main user’s guide, double-click the SmartSound 1.5 pdf icon. To open the update,

double-click the “What’s New in 1.6. pdf ” icon.

Two tutorials, one on music editing and one on video scoring, are located in the

Tutorials folder in the SmartSound For Multimedia ƒ folder on your hard disk.

SmartSound For Multimedia also has an electronic help system. Choose SmartSound

Guide from the Help menu to open the help system. You can search using general

topics, index entries, or by typing your own text to search for. When you’re done

using the help system, click the help window close box.

The service and support telephone number for SmartSound For Multimedia is 

818-718-9993.
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Web Graphics Mega Pack II from Nova Development

Web Graphics Mega Pack II is a collection of high-quality, ready-made graphics

designed for Web pages. The product includes accents, backgrounds, banners,

bullets, clip art, animations, dividers, and other types of images.

Using Web Graphics Mega Pack II

You use Web Graphics Mega Pack II directly from the CD. To view the available

images, follow these steps:

1 Insert the Web Graphics Mega Pack Volume 2 CD into the computer’s CD or DVD

drive.

2 Double-click the Web Graphics Mega Pack II CD icon, if necessary.

3 If you use Microsoft Internet Explorer, double-click the Start (Internet Explorer).htm

icon. If you use Netscape Navigator, double-click the Start (Netscape).htm icon.

4 Select a category of images by clicking the corresponding button on the left of the

browser window, or by clicking the text “Web Graphics Library,” and then selecting a

category from the window that appears.

Learning more about Web Graphics Mega Pack II

In the main screen, click “Using the Web Graphics” to see information about the

product, including how to incorporate the images into your Web pages.

The service and support telephone number for Web Graphics Mega Pack II is 

818-591-9600.
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